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1.  Introduction

Someplace is a personal database program for Windows 95.  It gives you a place to keep all the 
little (and sometimes not so little) odds and ends that don't fit neatly into a file cabinet or a 
traditional database program.  You can store in a single file all those important details that you 
need quick access to: phone numbers, web sites, access codes and passwords, health tips, 
financial reminders, etc.  You can also file less important paraphernalia: movie reviews, 
recreation ideas, clothing sizes of your relatives and so on.  Someplace can reflect your personal 
organization style: hierarchical categories or one big mess.  You can find what you need quickly 
regardless of your tidiness.

Someplace will recognize and dial phone numbers, and will connect to your favorite web sites if 
you have a web browser installed.  You can also use Someplace to launch programs to edit other 
files.

Flexible printouts let you access information away from the computer.

Someplace is Shareware and you are vigorously encouraged to register; the registration cost is 
only $15 and carries appreciable benefits.  Please read Section 7 for details.

2.  Installation

There are only a couple of files required to install Someplace, so in the interest of keeping file 
clutter to a minimum, no auto-install program is included.  You will need the following files on 
your drive:

PLACE.EXE
PLACE.HLP

Someplace will create a new data file DEFAULT.PLC if no data file is found, but if you want to
take the "quick tour" in the next section you'll also want to copy the file PRACTICE.PLC.

So to install Someplace, here's the recommended procedure:

Create a new subdirectory -- for the purposes of this document, we'll assume the directory is C:\
PLACE.



Copy PLACE.EXE, PLACE.HLP, and PRACTICE.PLC (for the quick tour) to the new 
directory.  (If you've downloaded the "zipped" version of Someplace, just unzip the file in your 
new directory.)  

Finally, you'll probably want to make a "shortcut" to place.exe on your desktop or in an 
appropriate folder.  Point the mouse to where you'd like to add a shortcut, then press the right 
mouse button and select "new", "shortcut".  Enter C:\PLACE\PLACE.EXE for the program and 
Someplace for the description, and you're set.

3.  A quick tour of Someplace

Let's give Someplace a quick spin.  Assuming that you've installed the program and copied the 
sample file PRACTICE.PLC to the PLACE directory, we'll guide you through the most 
commonly-used operations.

Start Someplace by running PLACE.EXE:  if you made a shortcut to the program, double click 
on it.  Alternatively, you can choose Run from the system toolbar and enter C:\PLACE\
PLACE.EXE (assuming that you used C:\PLACE for your installation directory).

If this is the first time you've run Someplace, a new data file DEFAULT.PLC will be started 
with the single category Default and no other data.  Later, this will be the file you'll expand with 
your personal information; for now, let's switch to a different set of data.  Choose Open from the
File menu.  You'll be asked whether to save your new DEFAULT.PLC file; answer "No" for 
now.  Choose the file PRACTICE.PLC from the list presented.

When the practice file is loaded, you'll see a "Category window" with the following categories:
Bicycle
Car rentals
Default
Financial
Garden
Medical
Phone
Web sites



The cursor in this window will start on the Default category.  (If you don't like the name 
"Default", you can change it -- see Section 5.)  To the left is the Note window, which shows the 
contents of the selected category.  In this case, the notes shown are:

-  This is a practice file for the Someplace program...
Change oil
Mow lawn

The cursor in the Note window is positioned on the first note, which contains more text than is 
shown in the cursor line.  The full text is available in the detail window at the bottom of the 
screen.

The categories shown are not built-in -- you are under no obligation whatsoever to like bicycling
or gardening.  You add categories as the need develops.

The "Default" category is a nice place to put "to do" items, since you'll see this category first.  
Other categories are like the folders in your file cabinet: places to collect related material.

Let's start by adding a note.  There are many ways to do this, all described in Section 4, but we'll
just press 'A'.  Enter two or three lines of text in the edit box.  You can finish your entry by 
pressing the OK button or by typing <Shift><Enter>.

You should see the first line of your new entry along with the other Default notes.  Delete the 
entry by pressing 'D'.  You'll be asked to confirm the deletion.

Select the "Financial" category with the mouse.  You'll see several several notes and 
subcategories in the Note window: the categories are "Mutual funds", "Tax" and "Stocks" 
(indicated by red) and the notes start with "Motley Fool" and "Wall Street Journal".  Double 
click on "Stocks" and see if you can find when New Plan Realty was purchased.  The special up-
arrow symbol means "Parent category" -- double click on this symbol to return to the "Financial"
category.

We might have organized this financial information a little differently.  "Motley Fool" and "Wall
Street Journal" are both publications, and they might deserve their own category.  Press the right 
mouse button and select "Add subcategory" from the menu displayed.  Enter "Publications" and 
press <Enter>.  Now you've got a new place to park the two notes.  Move the cursor to "Motley 
Fool" and press 'D' (or <Del> or <Ctrl X>) -- this will delete the note but leave it on the 
clipboard.  Double click on "Publications", then press <Ctrl V> to paste the note.  (There are 
several other ways to paste if you prefer.)  Move back to the "Financial" category and cut and 
paste "Wall Street Journal" in a similar manner.  

You don't have to be so tidy in your organization -- this author actually horrified his wife in the 
early years of marriage by filing everything under either "Financial" or "General Important 
Things".  This system works for simple lifestyles, but tends to break down as details accumulate.



Occasionally you'll want to move a category.  Suppose that you want to keep track of other, non-
financial, publications in the same category as "Motley Fool" and "Wall Street Journal".  It 
might be more fitting to make "Publications" a top-level folder.  Put the cursor on the 
"Publications" row and press the right mouse button, then choose the option "Delete subcategory
Publications".  You'll be asked whether you wish to 

Save category Publications and children for later paste?
Answer "Yes".  Press the right mouse button again and select "Paste tree as sibling".  This makes
"Publications" a sibling of "Financial", i.e. a top-level category.  Confirm that the contents of the
"Publications" category are intact.

Categories are a useful way of keeping lists of notes short enough so that you don't get 
overwhelmed while viewing them.  However, Someplace supports global searches (without 
regard to category), so you'll usually be able to put your hands on a note quickly even if you 
forget where you put it.  As an example, suppose you want to phone Fred Flintstone.  press 'F' 
(for find), then enter "Flintstone".  ("Flint" would work just as well.)  The cursor should land on 
Fred's record.  Now point to this record and press the right mouse button.  You'll see Fred's 
phone number as an option.  If you select this, Someplace will dial the number.  (Note that the 
digit '1' was prepended to the phone number.  The default rules for recognizing phone number 
are described in Section 4, and you can change these rules as described in Section 5.)

You can search for any substring of a target string.  For example, if you had searched for "in" 
you eventually would have found "Flintstone".  However, you probably would have found at 
least one other note first.  Press 'N' to continue a search to the next match.

You've seen that notes can contain phone numbers which Someplace can dial.  Notes can also 
contain program links and web links.  

A program link is like a shortcut on the Windows Desktop: double click on it and you run a 
program.  To add a program (or document) link, choose "Add program" from the right mouse 
button menu.  A dialog box is presented with three fields: program location, arguments, and 
description.  Enter C:\WINDOWS\NOTEPAD.EXE in the first field (assuming that C:\
WINDOWS is your Windows directory), leave the second field blank, and enter Notepad in the 
third field and press <Enter> (or click on OK).  You now have a "note" in a previously-unused 
color which says "Notepad".  If you double click on this note (or move the cursor to it and press 
<Enter>), you'll execute the Notepad program.  By using the argument field as well, you can 
specify a document for Notepad to edit.  

You could just as easily enter a document in the first field instead of a program.  Someplace will 
use the document associations to launch the appropriate program for viewing the document.

Notes can also contain web links.  Assuming that you already have an Internet connection 
established, press 'F' and find the note containing "Movies".  Point the mouse to this note and 
press the right mouse button.  You'll see a menu choice: "Link to URL..." which you can select 
to view Roger Ebert's movie reviews.  A quicker way to follow a link is to move the cursor to 
the note you want and press 'L' for link, or just double click the note.



This concludes our quick tour.  You'll eventually want to wade through the following reference 
sections, but you may have all the information you need for the time being.

4.  Operations in Someplace

We've tried to make mouse and keyboard use convenient and predictable in Someplace.  There 
are situations in which the same task can be accomplished in several different ways by using 
menus, accelerator keys, the button bar, or either of the mouse buttons, but hopefully your first 
instinct will suffice.  A good rule of thumb is: when in doubt, press the right mouse button.  This
will list a menu of valid options depending on the current program state and the location of the 
mouse pointer.

The general categories of operations in Someplace are:  navigating, adding items, editing items, 
deleting items, using items, searching, file operations, printing and utilities.  We'll explore each 
of these in turn.

Navigating

As is generally true in Windows 95, pressing the right mouse button will list options appropriate 
to the current context.  This is always a good fall-back technique if you forget quicker ways of 
getting things done.

Clicking once on the left mouse button will move the cursor to the indicated position.  Double 
clicking the left button will generally do something active -- usually the task we think you're 
most likely to be interested in.  If you double click a simple note, you'll edit it.  Double clicking 
a program link launches the program.  Double clicking a subcategory (or the up-arrow symbol 
for "up a category") takes you there.  

Pressing a key may be faster than using the mouse for many tasks.  Pressing <Enter> will 
generally have the same effect as double clicking the mouse.  There are keyboard shortcuts for a 
number of activities:

A Add note
E Edit note or subcategory
D (or <Del> or <Ctrl X>) Delete note
L Link to first URL in note
<Ctrl C> Copy note
<Ctrl V> Paste note

Several menu options are also available from the button bar.  To identify the function of a button
(if the button picture is too obscure), rest the cursor on the button until a text description is 
shown.

You can scroll through your notes by using the scroll bar or the up/down arrow keys.  If you 
press one of the Shift keys while pressing the arrow keys (or the other cursor keys), you'll scroll 
through the category window instead of the note window.



Adding items

Add note
You'll probably use the "Add note" function more than any other.  You can add a note through 
the Edit menu, or by pressing 'A', or by pressing the right mouse button.  You can also paste 
notes from the clipboard -- notes deleted from elsewhere in Someplace, or any text put on the 
clipboard by another program.  "Paste" is available from the Edit menu, via the right mouse 
button, or by pressing <Ctrl V>.

Notes are just (ASCII) text entries, and can be as long as you like.  It's especially handy to mark 
a block of text while web-browsing, copy the text to the clipboard, then paste a note into 
Someplace.  This can save you from reconnecting to an URL later if all you need is a portion of 
a web page.

You might want to keep a long or private note in your data file but keep it out of your printouts. 
The dialog box used for adding or editing notes or categories has a checkbox titled "Suppress in 
printouts" which you can use for this function.  If it's a category instead of a note, printing will 
be suppressed for descendent notes and categories as well.

When editing a note, you can insert the time by pressing <Ctrl T>, the date by pressing <Ctrl 
D>, or both by pressing <Ctrl B>.  See "Customizing" for instructions on changing the date 
format.

When adding a note, you can complete your entry by pressing on the OK button or by pressing 
<Shift> <Enter>.

Add category
When you start a new Someplace file, the only category is "Default".  You can add more 
categories via the Edit menu or by pressing the right mouse button.  Such categories are added as
siblings of the current category.
  
Add subcategory
Subcategories are like subdirectories on your hard drive: they provide a way of organizing your 
data in a hierarchy.  For example, you might have a category called "Financial" with 
subcategories "Bank accounts", "Mutual funds", "Taxes", etc.  Under "Bank accounts" you could
store notes representing your various accounts (account numbers, minimum balance 
requirements, etc.).  You could even continue the hierarchy by having categories "Checking 
accounts" and "Saving accounts" under "Bank accounts".  In practice, you'll seldom go past a 
second-generation subcategory.

You can add subcategories via the Edit menu or by pressing the right mouse button.

Add program 



Someplace is a natural for managing small to moderate-sized text entries, but what about your 
other data: spreadsheets, long documents, etc?  You can add program links alongside notes so 
that your data is only a mouse-click away.  Select the "Add program" option from the right 
mouse button menu.  You'll be prompted for three pieces of information:

· The path to the program or document,
· optional command line arguments, and
· a description.

Suppose you have a spreadsheet called MYSTUFF.XLS in directory C:\EXCEL\DATA which 
you need to edit often.  You can enter C:\EXCEL|DATA\MYSTUFF.XLS in the first field; 
alternatively, you can press the browse button to find the document.  In this case, leave the 
argument field blank.  Finally, enter something like MyStuff for the description.  The result will 
be an entry which looks like a note, but is a different color.  (The default color for executable 
entries can be changed; see Customizing.)  You can launch the document by double-clicking on 
the entry, by selecting Run from the right mouse button menu, or by moving the cursor bar to 
the entry and pressing <Enter>.

Editing items

You can edit any entry, including category names and program links.  Use the right mouse 
button menu, the Edit menu, or press 'E'.

If you're editing or viewing a large document, you may want to make the edit window larger.  
You can double click on the dialog window, click on the maximize button, or resize the borders 
to enlarge the edit area.

Deleting items

When you delete an item you may want to paste it elsewhere in Someplace, or into another 
program.  There is no separate "Move" option, so the Delete and Paste combination is used 
instead.

Delete note
You can delete a note via the Edit menu, through the right mouse button menu or by pressing 
'D', <Del> or <Ctrl X>.  The deleted note is placed on the clipboard, from which it can be pasted
in Someplace or in another program.

Deleting categories and subcategories
You can delete categories or subcategories using the Edit menu or the right mouse button menu. 
You are offered the option of saving the deleted "subtree" for pasting later.  A subtree consists of
the given category and all its descendent notes and subcategories.  Pasting a deleted tree 
elsewhere in Someplace lets you "graft" a tree to a more appropriate place.



Using items

Entries can be notes, categories or program links.  Notes can contain phone numbers which 
Someplace can dial, and web links which Someplace can follow.  You don't have to organize 
phone numbers and web links in any special format or order -- Someplace will make an educated
guess and show the dialing/linking options on the right mouse button menu.  If Someplace errs 
in its interpretation, you can always explicitly mark a number or address and indicate that you 
want to dial or link to it.

Up to 6 phone numbers in a note will be listed when you press the right mouse button; choose 
the one you want, and Someplace will dial it for you.  By default, a phone number is recognized 
by from 7 to 20 digits in a row (after hyphens and parentheses are removed).  If the length is 10, 
then a '1' is prepended for dialing.  These assumptions can be changed; see Section 5 for details.

You can always go to the detail window (where the highlighted note is shown in full) and use 
the mouse or keyboard to mark a number you want to dial.  When you press the right mouse 
button dialing this number will appear as an option.

Web address recognition is similar.  Any unbroken sequence of characters starting with "http" or
"ftp" (case doesn't matter) is taken to be a web or ftp address which can be fed to a web browser.
Only the first such link found is available through the right mouse button menu; if Someplace 
doesn't find the link you want, mark it in the detail window.  As a shortcut you can just press 'L' 
to link to the first web address found in a note.  Here's an example of how you can use this 
feature: create a 2-line note in which the first line describes a web site and the second line gives 
the address.  E.g.:

Motley Fool
http://fool.web.aol.com/fool_mn.htm

The first line will show in the note window.  Pressing 'L' will open the URL shown in the second
line.

Searching

You'll find the "search" option one of the most useful tools in Someplace.  Press 'F' (for "Find") 
and you will be prompted for a search string.  The search is global (rather than limited to the 
current category).  The cursor will be advanced to the first match found, or Someplace will 
gently beep at you if there is no match.  (Case is not significant in searches.)  Press 'N' 
repeatedly to find the next matches.  When no more matches are found, Someplace beeps.  If 
you press 'N' an additional time, the search cycles back to the beginning.

You can also select "Find" and "Next" from the menu and from the button bar.

File operations



When you start Someplace, the file DEFAULT.PLC is loaded by default.  (This can be changed 
-- see Section 5.)  Typically, you'll make a few additions or changes, then use the Save option 
from the File menu to save the modified file.  You can save the file under a different name (or to
another location) by selecting "Save as".  You can use New to start a new file, or Load to select 
an existing file.

If saving your work would overwrite a previous version, the old file is first renamed with the 
extension ".BAK".  For example, if you save DEFAULT.PLC and then realize that you have lost
information in doing so, just copy DEFAULT.BAK to DEFAULT.PLC.  Of course, you should 
have a more global backup strategy as well -- periodically copy your important files to tape or 
other disks.  In testing Someplace we have not yet lost any data, but lightning will strike us if we
assert that the program is incapable of misbehaving.

File operations may also be performed by using the button bar.

There is one other file operation which is available through the Utility menu: "Save as text".  
This saves a listing of your entire file in a text format which can be used by other programs.

Printing

To print from Someplace you must decide what you want to print and how you want to print it.  
Under the File menu there are four pertinent options: Print options, Print preview, Print, and 
Print setup.  

The first of these lets you specify whether to print all categories (everything in the file) or the 
current category.  If you choose the latter, you can also specify whether you want to include 
descendent notes and categories as well.  You can change the font size and number of columns 
temporarily.  (You can make these changes persistent and also change the font from the 
Configure menu.)

"Print preview" lets you view your output on the screen before using up paper.  (Save a tree!)

"Print" sends the document to the printer.

"Print setup" lets you choose the printer to which output will be directed, and also lets you 
determine the paper orientation (portrait or landscape).



"Print" and "Print preview" are also available on the button bar.

There is one additional print option which is found under the Utility menu.  Occasionally you 
may store an entire document as a single note, and you may wish to print only this single item.  
By choosing "Utility", "View note in Notepad" you can launch the Windows Notepad program 
with a copy of the note as the target file.  You can then use Notepad printing functionality to 
output the document.  It is important to understand that you are viewing a copy of the note and 
that any changes you make in this context will not be saved in your Someplace data file.  (The 
note is saved in the work file PLACE.TMP, which you can delete later if you like.)

The location of the Notepad program is assumed to be your Windows directory.  If it's not, or if 
you want to use a different editor for printing individual notes, change the NotePad variable 
described in Section 5.

You can also achieve the same effect by copying a selection to the clipboard, then pasting into 
your favorite editor.

Utilities

There are three options available under the Utility menu.  The first, "View note in Notepad" is 
described above in "Printing".  "Save as text" was previously covered under "File operations".  
The last alternative, "Split entry", we'll describe here.

Suppose you have a file of names and phone numbers, with one name/phone number pair per 
line.  It would be nice to import this as a "Phone" category in Someplace.  Assuming that you've 
already set up a category in which to put the new records, put the file on the clipboard (e.g. 
using Notepad) and paste the clipboard into Someplace as a note.  Now you have a single entry 
with many phone numbers, most of which won't show on the screen.  By choosing "Split entry", 
the note will be separated into one entry per line.

5.  Customizing Someplace

Many features in Someplace can be customized.  The most common alterations may be 
performed through the Configure menu, while many more obscure adjustments may be made by 
editing the System Registry directly.

The Configure menu



The main options available concern screen and printout characteristics, the default category and 
data file, and the use of web linking.

Screen colors
Here you can change the colors used for various functions in Someplace:
Category -- the color used in the Category window and for subcategories in the Note window
Detail -- the color used in the Detail window for expanding the note at the cursor
Note -- the default color used in the Note window
Execute -- the color for program links
NoPrint -- the color for non-printing notes

Screen font
Let's you change the font used on the screen

Show past line break
Normally a note is truncated at the first line break in the Note window.  For example, if your 
note was:

Mary had a little lamb,
its fleece was white as snow

Then only "Mary had a little lamb," would show in the Note window (but the full text will 
always show in the detail window and in the dialog used for editing the note).  If you turn on the
"Show past line break" option, you'll see:

Mary had a little lamb¨its fleece was white as snow

Printing font



Lets you change the font used for printing your data

Printing columns
Lets you change the number of columns used in a printout

Printing margins
Lets you specify paper margins in inches

Install registration code
When you register Someplace, you'll be given a registration name and code to enter in this 
dialog.  Installing this information will show you as registered on the title bar, and the annoying 
monthly registration reminders will cease.

Default category
When you start Someplace the starting category will be "Default" (and this category is created if 
not found).  If you want to substitute a different name for this behavior such as "To do", choose 
this option.

Default file
You can run Someplace with an argument (e.g. using the "Run" system option) specifying the 
data file; for example: SOMEPLACE C:\MYDIR\MYDATA.PLC.  If you don't indicate a file, a
default will be used; this is originally DEFAULT.PLC in your Someplace directory.  If you want
the default to be a different file, use this option.

Enable web links
If you have a web browser and an internet connection, Someplace will follow web links if this 
option is enabled.  Turn the option off if you don't have a browser.

Other configuration options



We didn't want to clutter up the Someplace menu too much, so the more obscure configuration 
options will be left to be changed "by hand" in the System Registry.  For now, this pertains to 
just a few options.  To change or set Someplace configuration information, run REGEDIT from 
the system toolbar Run option, then click successively on the HKEY_CURRENT_USER, 
Software, and Place folders.  If the Someplace variable already exists, just double click it in the 
right-hand window and change its value.  If it's not listed, create it by choosing Edit, New, then 
String or DWORD value (as shown below), and enter the variable's name.  Once the variable 
exists, you can change its value by clicking on it.

HorizRatio and VertRatio (string)
By default the width of the Note window takes up 80% of the available space horizontally 
(leaving 20% for the category window).  The Someplace variable HorizRatio is .8 in this case.  
If you add the variable using Regedit and change its value to .7, you'll have a wider Category 
window (30% of the total).  Similarly, the VertRatio variable defaults to .8, giving the Detail 
window just 20% of the total height.

EditFont (DWORD)
If you set this to 1, the screen font will be used in note edit dialogs as well as in the Note, 
Category and Detail windows.

PhoneLength1 (DWORD)
This is the number of digits in a phone number.  (Default=7)  You can use PhoneLength2 
(Default=10) and PhoneLength3 to recognize other phone numbers.

PhonePrefix1 (string)
The sequence of digits to dial before a phone number of length PhoneLength1.  For example, the
string might be "9" for an outside line.  Similarly you can set PhonePrefix2 and PhonePrefix3.  
The defaults are nothing for 1 and "1" for 2.

ClickURL (DWORD)
If web linking is enabled and you double click on a note containing an URL, you'll link to that 
URL (rather than editing the note).  Set ClickURL to 0 to turn off this feature.

DateFormat (DWORD)
You can insert the date when entering a note by pressing <Ctrl D> or <Ctrl B>.  You can control
the date format using the following values:

0 - Normal



1 - Terse
2 - Numbers
3 - EuropeanNumbers

4 - European

We're willing to make most default Someplace behaviors subject to user modification in this 
manner.  If there's something you'd like to change, let us know and we'll add new Regedit 
variables.

6.  Tips for using Someplace effectively

Someplace is good at storing and locating short (but possibly important!) notes that don't warrant
the full database treatment in which there are formal field definitions.  While you can store long 
documents directly in Someplace, this will tend to slow down file operations and searches.  A 
better strategy is to keep your longer documents separate and include links to these documents in
Someplace.  Links can be added with the "Add program" option from the right mouse button 
menu.

If you've previously put a long entry in Someplace that you would like to make a separate file, 
you can copy and paste the entry into Notepad, Word or your favorite application.  An 
alternative is to select Utility, View note in Notepad, then save the Notepad file to a new name 
(using Save As).  You can then delete the entry from Someplace and add a link to the new file.

7.  About Shareware

"Shareware" is a means of software distribution with several advantages to the consumer.  The 
complete package including documentation may be freely copied and distributed (subject to the 
constraints below).  Word of mouth provides a more accurate and less expensive way of making 
a product known than magazine advertisements, and the savings keep Someplace's cost down. 

The registration cost for Someplace is $15 (MC/VISA or check drawn on US bank).  This 
licenses you to use the current version and one major upgrade (and probably several minor 
upgrades), and gives you telephone support for the licensed versions. You can download 
Someplace from our web page 

http://cs.cs.appstate.edu/u/cs/mh/granny 
or for an extra $3 we'll send you a disk with the current version.  Regardless of how you obtain 
the program, when you register we'll send or email you a code which will make your version 
"registered".

If you don't have Internet access and want to try out the shareware version of Someplace, send 
us a check for $3.



Shareware does not mean 'public domain'.  Distribution is permitted only if the package stays 
intact; all files should be passed on in unmodified form.  Commercial distributors may sell 
copies of the package subject to the conditions described in the VENDOR.TXT file.  
Restrictions to use by an individual are described in LICENSE.TXT.  One of these restrictions is
that unregistered use of Someplace past a trial period of 60 days is prohibited.

To register, phone (with MC or VISA) (704) 264-6906,  fax (704) 264-4634, or mail payment 
to: 

Granny's Old-Fashioned Software
297 Camp Rock Road
Boone, NC 28607, USA

North Carolina residents please add 6%.  Please pay by MC/VISA, check in US funds drawn on 
US bank, or by cash.  Foreign orders may send cash in dollars or in local currency (no coins), 
but please allow a small margin for exchange rate fluctuations.

An order form is provided under the name REGISTER.TXT.  Site licensing is also available; 
please call for current rates. 

You can contact use by email at: mh@cs.appstate.edu.
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